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Introduction 5

1 Introduction
Preliminary topics:
Capabilities

Genera Procedure

Types of Windows

1.1 Capabilities

CRY SCON isageneral crystallographic conversion program, with the following capabilities.
See Genera Procedure for an overview of the main possibilities.

1) Data Entry. Data can be imported from several popular crystallographic file formats, read in
through a "free-form" file input, or entered manually.

2) Tranformation of unit cell and atomic coordinates. You can convert to asub-cell or
super-cell or simply trandlate to a different origin; or any combination of these. When
converting to a sub-cell the positions of presumably coincident or superimposed atoms are
averaged, and when converting to a super-cell the extra symmetry-unique atoms which may be
required are generated. In any case the result is a set of symmetry-unique atoms for the target
cell and symmetry, suitable for entry into crystallographic software such as Fourier analysis,
least-squares refinement or structure drawing (Control Window, Transformation Parameters
dialog).

3) Change of symmetry in the same or different unit cells. Y ou can convert to a sub- or
super- symmetry group, or even anon-related space group. Asin the case of cdll transformation,
new atoms are generated and/or old atoms are averaged as necessary, and the result is a set of
symmetry-unigue atoms for the target cell and symmetry (Control Window,

Transformation Parameters dialog).

4) Transformation of anisotropic temperature factors and atomic vector s (e.g. magnetic
vectors).

5) Computation of bond lengths and angles in either the original or transformed structures
(Bond L engths and Angles).

6) Conversion of temperatur e factors among the different common isotropic and anisotropic
forms (Export file).

7) Conversion of atomic parameter s among sever al different crystallographic database
and structure refinement formats (Export file).

8) Transformation of hkl index data, such as diffraction data (Transformation Parameters
dialog).
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6 CRYSCON Help

9) Computation of powder diffraction intensitities and simulation of powder diffractograms
(Powder Diffraction).

10) Simulation of precession photographs (Precession Pattern).

11) Expansion of layers, leaving the layers themselves unchanged, creating space in between
(Expand Layers).

1.2 General Procedure

Thefirst step isto enter or import the data for the crystal to be transformed. To import from one
of several file formats, choose Import from the File menu. After selecting the format, you will
see the Import File dialog. The 3-letter file extension ".xxx" in the edit box will be used to filter
thefiles (that is, the Open File dialog will show only the files with this extension). Any
changes you make in file extensions will be saved for future runs. Some formats may offer a
choice of symmetry option; if the file actualy lists symmetry "as XY Z", that isin the form of
the positions of the general equipoint for the space group in the International Tables for X-ray
Crystallography.

To enter the data manually, choose New from the File menu.

In the first dialog which appears, Title/Axes, supply an 80-character title, and specify the unit-
cell parameters.

The two Symmetry options are Space Group and Custom. The Space Group option lists almost
all standard orientations and origins, so thisis usually the first choice. You cantypeina
Hermann-Maughin or Hall symbol, or give the International Tables number, but it is normally
safest to select the space group in the scrolling list and double-click on it or click the Select
button (be sure the symbols/number for the selected group appears in the edit boxes above). If
you type in the H-M symboal, it isinterpreted either according to Volume | of the 1952 edition of
the International Tables, or Volume A of the 1983 edition. The main difference between the
two isthat in Volume | the default orientation for monoclinic crystalsis a-axis unique, and in
Volume A the default isb-axisunique. That is, if you typein "P2/m" the orientation will be
different. Of course to be certain you can also type in the long form "P112/m" or "P12/m1", or
select one of thesein the list.

If the space group is a non-standard one, such as C-1 (Charl), it will be necessary to use the
Custom Symmetry option. Often you can start with the Space Group option and then switch to
the Custom option (Change Symmetry Option button) and make modifications as hecessary.
In thelist of operations you must supply (if they are not there aready), the coordinates of the
equivalent positions of the general equipoint aslisted in the International Tables, one per line.
If the space group is centrosymmetric and the origin is on a center of inversion, select the
Centric radio button and supply only half the operations — the center will be supplied by

CRY SCON. If the originis not on a center of inversion, you must supply all the operations and
select the Acentric radio button.

In the Input Atom (Site) dialog, supply the standard atomic parameters. Thetypeis normally
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Introduction 7

the atomic number, but it could also be an arbitrary number. If thereisonly one occupant of the
site or position it is not necessary to enter the datain the list box. If there is multiple occupancy,
click on Add and supply the parameters as necessary in the Atom Sharing a Site dialog. For a
cell/symmetry tranformation such multiple occupancies are seldom used - they are simply
carried over for possible Export. The label and type of the main entry will be those of the first
occupant.

When the atom list is complete you are done with the "OId" crystal. The atom list is shown in
the Control Window. You can save thisfile or document at any time with the Save or SaveAs
optionsin the File menu.

General Procedurefor Cell/Symmetry Tranformation

Now click on the Transfor m button to specify the parameters of the "New" crystal. In the
Tranformation Parameters dialog, click on the Symmetry button if the symmetry of the New
crystal isto be different from the old symmetry. Specify the symmetry as above. The symmetry
specified here pertains to the New orientation, not the Old. The default symmetry is the same as
the Old.

Three types of transformation can be carried out - Translation only, Input atoms only, and
Full unit cells. Input atomsonly isthe only option which will transform anisotropic
temperature factors and/or atomic vectors (magnetic, displacement, etc.). See
Tranformation Parameters for more details.

The parameters specified in the Tranformation Parameters dialog, going downward in the
dialog, correspond to the operations successively carried out by CRY SCON.

First, trand ations may be applied to the input atom coordinates (Pre-symmetry translations).
If the origin for your atom coordinates does not correspond to that of the standard symmetry
specified for the Old crystal, corrections must be made here. If you select Translation only ,
thisisal that will be done — the remainder of the parameters are ignored.

I nput atoms only option:

CRY SCON appliesthe Pre-matrix trandlations, transforms the coordinates of the Old input
atoms only, and applies the Post-matrix trandations. (Pre-symmetry translations are not
used). Thisgivesaset of input atoms for the New structure, and the tranformation is compl ete.
Anisotropic temperature factors and atomic vectors are transformed to the new unit cell.

Full unit cells option:

CRY SCON now generates all the atomsin the Old unit cell. If the origin of the New unit cell
differs from that of the Old, with respect to the common symmetry elements, you must make
corrections in the Pre-matrix trandglations edit boxes. Such differences among
sub/supergroups are common, and it may be necessary to study the diagrams and coordinatesin
the International Tables to get these translations.

CRY SCON now transforms the coordinates according to the matrix supplied. Now it has the
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8 CRYSCON Help

contents of the Old unit cell, expressed in coordinates of the New unit cell.

In order to fill out the contents of a supercell, or to shift the contents for a reorientation,
CRY SCON now systematically adds and subtracts the New unit-cell vectors.

Next, in order to average atom positions for a subcell or an increase in symmetry, CRY SCON
similarly adds and subtracts the Old unit-cell vectors. If the position of a new atom generated in
this way falls within the specified distance, or Tolerance, the atomic positions are averaged.
CRY SCON keeps a running count of the number of atoms averaged in thisway. The tolerance
should be large enough to avoid having quasi-superimposed atoms in the result, but of course it
must be |ess than the smallest bond length in the structure. Setting this may take some trial and
error. A vaue of 0.4-0.5 seems to be large enough for even rather extreme cases of atomic
snhifts in sub/supercells and sub/supergroups.

Post-matrix trandations may be applied here if the standard origin for the New space group is
different from that of the Old space group. Thisis an alternative to the Pre-matrix translations
- it should not be necessary to use both.

At this point, there should be a complete and hopefully realistic set of atoms for the New unit
cell. Depending on the symmetry change, the new set may or may not conform to the New
symmetry. CRY SCON now appliesthe New symmetry to eliminate symmetry-equivalent
atoms. Again atoleranceis applied to decide if atom positions are "coincident”. This generates
astandard set of symmetry-unique atoms, or the "asymmetric unit". However, in many cases
when generating a subcell or increasing the symmetry the averaging process does not put the
new atoms exactly on special symmetry positions.

CRY SCON now applies the new symmetry to the supposed asymmetric unit, to generate a
complete set of atoms for the New unit cell. Y ou should know, based on simple volume
considerations, how many total atoms are expected in the New unit cell. If the number of atoms
in the unit cell generated in this step does not agree with that generated by transformation
(before symmetry consolidation), CRY SCON now prints out the number it has generated and
asksif you want to recycleto refine the location of atoms on special positions. If the atomsin
specia positions were not located within tolerance (.000177?) in the previous step, extra atoms
will be generated, and the total generated will be greater than expected. If so, "recycling” will
repeat the previous step of reducing to the asymmetric unit, and hopefully averaging will place
the atom positions closer to the symmetry elements, if not on them (within tolerance). It may
take several cycles of no change in number before the number of atoms generated comes down
to the number expected. If there appearsto be no improvement after 3 or 4 cycles, inspection of
the resultsisin order - the correction to the atomsin special positions may be obvious, or it may
appear that the matrix and/or translations are not valid.

When you decline another cycle, the process is terminated and the results appear in a special
Output Text or Edit window (see Types of Windows). Thiswindow has a separate menu bar,
with standard entries for text editing. This text document or output file can be saved separately
from the input data (which isin files with extension .cco) using the Save and SaveAs option in
this menu bar.

Note that when different input atoms are consolidated during a transformation, for example
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Introduction 9

super- to sub-cell or on increasing the symmetry, CRY SCON does not attempt to combine the
two sets of occupancies; it simply takesthe list of occupants from the first atom generated.

In the Full unit cells option, CRY SCON does not attempt to transform anisotropic temperature
factors; if there are anisotropic temperature factors they are converted to isotropic B'sin the
New structure. Atomic vectors are not transformed either - the New atoms will have vectors
which are smply copied from the first Old input atom which was used to generate the New
atom.

To go back to the main data input, click on the Control Window or use the Window menu to
switch. The process or tranformation can be repeated without removing the Output window, but
its contents will be replaced. If you want to save successive results files, use the SaveAs option
(when the Ouput file is active or has the focus) to give the file a different name (eg myfilel.ccd)
before recalculating.

The transformed (New) input atoms (symmetry-unique atoms) can be converted into the origina
(Old) input atoms with the Transformed to Input option in the Input menu.

Other Operations
There are several things which can be done without Transformation. All these operations may
be done on the transformed atoms, as well asthe original atoms, after a transformation has been

carried out.

Bond Lengths and Angles. The Bond L engths and Angles button in the Control Window will
call up aspecial dialog for this.

Powder and Precession diffraction simulation. See the Powder Diffraction and
Precession Pattern dialogs.

Exporting Files. Y ou can write files containing either the Old data or the New data in most of
the same format as are available for import. Select Export in the File menu. In the case of input
filesfor structure refinement programs, such as SHEL X, RIETAN, DBWS/LHPM, etc.

CRY SCON cannot supply all of the required parameters, only the symmetry, unit cell and
atomic positions and temperature factors. Non-essential information such as commentsis also
not necessarily passed on, but in most cases the relevant lines can ssmply be copied from the
import file (Old crystal) to the export file (New Crystal).

1.3 Types of Windows used in CRYSCON

CRY SCON uses four types of windows besides dialogs and alerts; the Startup window, the
Control window, Text windows and Graphics windows. In Windows, each window has its own
menus; in Macintosh, the menus are at the top of the screen. The menus and commands therein
depend on which type of window is active.

When starting up CRY SCON, the menus displayed include only a File menu and a standard
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10 CRYSCON Help

Help menu. Use the commandsin the File menu or the buttons in the window itself to start a
new CRY SCON data set, or read an old one from afile.

After you have entered or read in the data for a CRY SCON file, the Control Window opens.
Thisisactually akind of dialog, but it cannot be dismissed without closing the current data set.
Only one data set at atimeisalowed in CRY SCON, and there is only one Control Window.
When this window is active, the File Menu has additional commands such as Export, the View
Menu has Powder Diffraction and Precession Pattern options and thereis an Input Menu for
data input and modification. Note that the Print, Print Preview and Metafile optionsin the File
menu are inactive - they are active only when a Graphics window (below) is active.

The Transform button in the Tranformation Parameters dialog lists the transformed atom
parameters and other data to a separate Text window. The Listing option in the

Powder Diffraction dialog (File Menu) lists the data to a Text window, as does the

Bond L engths and Angles dialog (called from the Control Window). When any of these Text
windows is active, the menu bar contains standard menus for saving, printing and editing the
contents. Each window actually displays the contents of afile, called respectively Powderl.dat,
Powder2.dat and BONDS.DAT. These files are written over again each time the respective
option iscalled, soif they are to be preserved they should be saved with the Save As command
in the File Menu, using a different name.

The Powder Diffraction and Precession Pattern dialogs (Diffraction Menu) present output in
Graphics Windows. When a Graphics menu has the focus, the Print, Print Preview, Raster and
Metafile or PICT options in the File Menu produce graphics output, essentially what is shown
on the screen. There are four possible Graphics Windows, for Powder Pattern Old and New
atoms, and Precession Pattern Old and New atoms.

2 Menus and Dialogs

Startup Window Menus

Control Window Menus

Text Window Menus

Diffractogram Windows

2.1 Startup Window

Startup Window (see Types of Windows).

Thiswindow appears when CRY SCON isfirst started, or when a data set
(Control Window) is closed.

It has its own menu bar, and the following buttons for getting a datafile into
CRY SCON.

© 2009 Shape Software



Menus and Dialogs 11

New - Step-by-step input of anew CRY SCON data set.
Open - Open anold CRY SCON datafile.

Import File - Shows a pop-up menu with the file types currently supported. This
includes:

---- CCDC FDAT filesfrom the Cambridge Crystallographic Data Centre.

---- SHEL X .INS filesfrom the program system of Prof. G. Sheldrick.

---- CIF - Crystallographic Information Files.

---- DBWS/LHPM Rietveld input files.

---- ICSD Inorganic Crystal Structure Databasefiles.

---- ORTEP Original or ORTEP Il atom information.

---- XTLVIEW Drawing program.

---- VIBRAT (.MQOT) Graphic output filesfrom VIBRATZ.

---- PDB Protein Data Bank files.

---- RIETAN Rietveld program files.

---- GSAS Datafiles (.EXP) filesfrom the Los Alamos Lab system - may include
magnetic vectors.

---- AM MINERAL. Datafilesfrom the American Mineralogist structure data base.
---- FULLPROF. All-purpose refinement program - may include magnetic vectors.
---- Free-form (.inp). Thisallows input of atomic coordinates and other information
from amost any source.

---- Ravel ATOMS. This program is not the same as ATOMS by Shape Software, but is
for EXAFS Analysis.

---- WIEN2K. This package performs electronic structure calculations of solids using
density functional theory (DFT).

Exit/Quit - Quit the CRY SCON program.

2.1.1 File Menu - Startup Window
New - Step-by-step input of anew CRY SCON data set.

Open - Openanold CRYSCON datafile.

Close - Closethe current graphics window.

Save - SaveaCRY SCON datafile.

Saveas - SaveaCRY SCON datafile with anew name

Import File - Shows a pop-up menu with the file types currently supported. Thisincludes:
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12 CRYSCON Help

--Free-form (.inp) Thisallowsinput of atomic coordinates and other information from almost
any source.

--CCDC FDAT filesfrom the Cambridge Crystallographic Data Centre.

--SHEL X .INS filesfrom the program system of Prof. G. Sheldrick.

--CIF - Crystallographic Information Files.

--DBWS/LHPM Rietveld files.

--ICSD Inorganic Crystal Structure Database files.

--ORTEP Origina or ORTEP Il atom information.

--XTLVIEW Drawing program.

--RIETAN Rietveld program files.

--GSAS Datafiles (.EXP) filesfrom the Los Alamos Lab system - may include magnetic
vectors.

--AM MINERAL Datafilesfrom the American Mineralogist structure data base.
--FULLPROF . All-purpose refinement program - may include magnetic vectors.
--ATOMS Atomic structure plotting program (Shape Software).

--VIBRATZ Normal-coordinate calculation program for crystals and molecules (Shape
Software).

--Ravel ATOMS This program is not the same as ATOMS by Shape Software, but i<
for EXAFS Analysis.

--WIEN2K This package performs electronic structure calculations of solids using
density functional theory (DFT).

Quit - Quit CRY SCON.

2.1.1.1 Import Data File
Dialog Box: Import File [ FileMenu]

If there is a data set in memory which has been modified, you are asked if you want to save the
changes.

If there is more than one data set or phasein the file, the Data Sets...in Import File dialog will
present you with alist. The name of the CRY SCON data file will be taken from the name of the
file, and thetitle (Control Window or Title/Axes dialog in the [nput Menu) will be taken from
the data set or phase. The extension .CCO will be appended to the structure file.

File Extension. The three-letter extension (.XXX) which identifies the file type under
Windows may be specified here - only files of that type will be shown in the Open File diaog.
To show all files, enter ".* ",

Sour ce of symmetry (some formats lack this option). If you select Use positions as xyz, in
which symmetry operators are given in the form of positionsin the general equipoint asin the
International Tables, the symmetry option (Input Menu) will be Custom Symmetry. After
import, you may need to check the Symmetry option to be sure the centric/acentric choice and
the Bravais lattice type are correct (some formats include a center of inversion and/or lattice
centerings in the operators and some do not). If you select Space group symbol, the

Space Group symmetry option will be used. The Hall symbol, the Hermann-Maughin symbol,
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and then the International Tables number will be used in that order if present. If you select
Use positions as xyz and the information on operations is not present, the symmetry option will
default to Space group symbol. The H-M space-group symbol, Hall symbol, and space-group
number are awaysread if present.

If symmetry is present in the "xyz" or operation form, thisis usually the safest option However,
this option does not give information on systematic extinctions or true d-spacings, which are
required for the Powder and Precession options. It is usually possible to derive the correct
space-group symbols from the operations using the Get Symbol option in the

Custom Symmetry dialog.

Atom types (some formats lack this option). If adistinct atom type number is not present in the
input, CRY SCON will try to assign an atomic number to each input atom either from the first
one or two characters of the atom label itself, or from a separate atom type label if that i<
present. In diffraction refinement file formats, this separate atom type label typically identifies
the scattering factor, and it may be a matter of operator preference whether this or the atom label
(if either) will identify the element.

Note that in the case of multiple atoms with the same coordinates, that is multiple occupancies
for asite, CRY SCON consolidates them into one input atom, but preserves the information on
the site occupants (see |nput Atoms).

File types supported, with the default extension:
**** Free-Form - .inp. Thisimportsfilesin the free-form format described el sewhere (

Atom Parameter Files ). Note that thisformat has been expanded, so that essentially all relevant
datafor acrystal may be entered.

**** CCDC (Cambridge Crystallographic Data Centre) FDAT - .fdt. Thefilesnormally
contain a unigque set of input atoms, which are the same as those required for input of acrystal in
CRY SCON, plusin many cases some extra symmetry-derived atoms necessary to complete the
molecule; CRY SCON will use only the unique set of atoms, omitting the extra ones.

***% SHEL X-93 - .ins. CRY SCON is programmed only for SHEL X-93 files, athough it may
also be possible to read SHEL X-76 files.

Symmetry . The Custom Symmetry option will be used. Typically the true space-group symbol
can be recovered from thetitle. CRY SCON will read the SYMM linesin the SHELX file only
if they arein standard International Tables format - the trandational part must precede the
positional part (i.e. 1/2+x, not x+1/2). If the symmetry was copied from the Tables , there
should be no problem. Y ou can edit the symmetry operators after they areread in.

FRAG instruction . Atoms listed between this instruction and the FEND instruction will be
ignored.

RES! instruction . Atoms listed after thisinstruction will be included, but not treated in any

special way.
Hydrogen atoms . SHEL X has severa sophisticated ways of locating hydrogen atoms which are
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14 CRYSCON Help

not duplicated by CRY SCON. Frequently, the positions of the hydrogen atoms are not in the
INSfile, and must be taken from the output. The output lines giving the hydrogen positions can
be copied into the .INSfile. If thisis done, atype or SFAC number must be inserted after the
label and before the coordinates. The hydrogen lines can also be put into a separate file and
read in with the SHELX +filename include-file instruction.

Most of the instructionsin a SHEL X file will be ignored. However, CRY SCON may not know
all the current instructions. If it cannot identify an instruction, it tries to read the line as an atom
line (thisisthe way SHEL X works). If thisfails, you are asked if you want to add the first four
letters of the line to the list of instructions to be ignored. These instructions-to-be-ignored are at
the end of the SCRPTR setup file, separated by spaces and preceeded by the number of
instructions. You can edit thislist if necessary.

**** CIF (Crystallographic Information Files) - .exp. CRY SCON uses only asmall number
of the possible dataitemsin a CIF file and recovers only the most basic information. The
dictionary file, CIFDIC.SHT (a shortened version of the complete CIF dictionary), must bein
the home directory (the directory containing the CRY SCON.EXE file). CRY SCON will read
macromolecular (mmCIF) files, and if the crystal-to-Cartesian transformation matrix in the form
of _atom_sites.fract_trans_matrix lines, CRY SCON will set up its own matrix so that the
Cartesian coordinates may be converted back to fractional coordinates on the crystal axes. See
below under PDB files for further details of Cartesian to crystal transformations.

**** DBWS/LHPM Rietveld - .dbw/.Ihp. The DBWS and LHPM formats are very similar.

Inthe Atom type numbers from: box, the Type label option will select the NTY P field which
usually contains the elemental symbol for recovery of the scattering factor.

Three different versions of DBWS file are recognized: 9002, 9411 and 9807. Trying to read a
9002 file may cause an error on the first pass, as CRY SCON tries to read according to the later
formats, and in that case you will have another chance to read again according to the 9002
format. Fileswith only one phase are more likely to be read correctly (but please report any
problems reading valid DBWSfiles).

***% |CSD ( Inorganic Crystal Structure Database) - .ret/.cry. Threetypesof ICSD file are
supported:

1) Filesfrom the current CD-ROM database, accessed by the program RETRIEVE. The
RETRIEVE files must be written from the DATA window using the PRINT option, not as
export files (if there is sufficient demand, export files may be supported). That is, thefile
should be a copy of what is shown on the screen in the RETRIEVE program.

2) Filesfrom the Canadian Scientific Numeric Database System (CAN/SND). This service
may no longer be available. Thefilesarereferred to as CRY STIN.

3) Filesintheoriginal CRY STIN format (or closeto it), available from the Netherlands CAOS
information system, from ETH (Switzerland) and perhaps other sources. Thesefilesare also
referred to as CRY STIN.
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Please contact Shape Software if you have ICSD files which cannot be read by one of these
options. The best procedure is to send samples of the files by email or an afloppy diskette.

In CAN/SND files, CRY SCON will usethe "NA:" line for thetitle; in RETRIEVE and original
CRYSTIN files, CRY SCON will usethefirst "MINR" lineif present, otherwise it will use the
"NAME" line.

**** ORTEP - .ort. Thisimportsthe unit-cell parameters, symmetry, atomic positions and
thermal datafrom original or ORTEP I files. It does not read the boundary and plotting
instructions.

**xx XTLVIEW - xtl. CRY SCON may need to shift the fractional coordinates to insure that
the origin is placed on a center of inversion.

****x FULLPROF - .exp. The"User-supplied" non-magnetic and magnetic options (JBT = +-4
or +-5) are not directly supported - crystallographic and magnetic parametersin files using these
options will be read asif one of the standard options were used. Magnetic information is aways
read as vectors in the crystallographic axes (not as polar or other coordinates), and FULL PROF-
specific magnetic symmetry is not currently used.

***% American Mineralogist Structure Database - .amc. The American Mineralogist
structure database is currently available on the Internet at www.geo.arizona.edu/xtal-cgi.test.
This may change, but the database should be locatable by searching for American Mineralogist.

**x% GSAS- .exp. The General Structure Analysis System (Los Alamos) can give magnetic
moment vectors.

****x RIETAN - .xyz. Thisformat gives complete symmetry operations, including a center of
inversion and lattice centerings if present, as numeric matrices. CRY SCON will convert the
matrices to "xyz" form and use the Custom Symmetry option. It will also attempt to identify the
center of inversion and lattice centerings and will remove them with your approval.

***x% ATOMS (Shape Software) - .str. CRY SCON will read and store data on atom colors and
radii from these files. Such data will be written into free-form (.inp) files when exported, and
can then be read back into ATOMS.

**** VIBRATZ (Shape Software) - .vbr. CRYSCON will read the main data files (.vbr)
from the Windows version.

**** PDB - .pdb. PDB filesareintended primarily to present data on protein structures
as molecules, and the atomic coordinates are aways given in Cartesian form. However,
CRY SCON can use the information in the SCALERN lines (Cartesian to crystal
transformation matrix) and the CRY ST1 line to recover the fractional coordinates and
space-group symmetry for the original crystal, through the CRY SCON transformation.
In some cases thisinformation is not present - if it is present you will be asked if you
want to import the matrix. Note that the transformation matrix given in the SCALEN
lines is sometimes not sufficiently precise (because of limitation to 6 places after the
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decimal point) to recover the original unit-cell parameters (as given in the CRY ST1 line)
precisely. The cell parameters derived by CRY SCON for the new crystal are those
derived from the transformation matrix, not from the CRY ST1 line. After importing,
you should check the cell parameters and correct as necessary.

The transformation matrix is imported into the Transformation dialog, and the space
group for the crystal will be that for the new crystal. The old "crystal” will have the
origina Cartesian atomic coordinates, and space group P1. In the Transformation
dialog, specify the transformation type as Input Atoms Only, so that CRY SCON will not
try to fit the original atomsin aunit cell (if you specify Full Unit Cell there may be no
generated atoms, as the "unit cell” isonly 1 Angstrom on aside.

The Input Atoms Only option will not try to generate the atoms in the New unit cell, or
try to check whether al atoms are symmetry-unique. If redundant atoms are present, a
further cycle may be necessary. In the Control Window, click the New to Old button,
Then Transform. The matrix for this step should be the unit matrix, and the symmetry
for Old and New should be the crystal symmetry, that isthe symmetry for the original
crystal. Usethe Full Unit Cells option.

**** RAVEL ATOMS- .inp. Thisprogram is not the same as ATOMS by Shape
Software, but isfor EXAFS Analysis.

***x WIENZ2K - .stw. The program package WIEN2k performs electronic structure
calculations of solids using density functional theory (DFT). CRY SCON will read the
struct input files, but will only recognize file extensions with three characters, so it may
be necessary to rename the files, search manually in the File Open dialog (enter * .struct)
or usethe"all files' option. Some files may have the space-group number and symbol,
but the orientation may be ambiguous and Use positions as xyz should normally be
selected in the Import File dialog.

**xxx | ZA (zeolites) - .iza Filesfrom the International Zeolite Association database.

2.1.1.2 Data Sets in Import File
Dialog Box: Data Sets...in Import File [ Import File Command - File Menu ]

When you open an Import File, CRY SCON will search through it to find all the data sets within
it, up to alimit. If thereis more than one data set, this dialog will present you with alist. The
name of the CRY SCON data file will be taken from the name of the file, and the title

(Control Window, or Title/Axes dialog in the Input Menu) will be taken from the data set,
phase or crystal selected. The extension .cco will be appended to the structure file.
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2.1.1.3 Importing mmCIF files

The CIF file was originally designed to transmit crystallographic structure information. The
mmCIF fileis avariant which transmits data on macromol ecules using atomic coordinates on
Cartesian axes, not fractional coordinates on crystallographic axes. In thisform, the data are not
usable by CRY SCON.

However mmCIF files usually have the information necessary to transform the coordinates back
to crystallographic axes. The Cartesian-to-crystal transformation matrix isin lines of the type

_atom_sites.fract_transf_matrix[1][1] 0.023496

which make up a 3 x 3 transformation matrix, plustranslations. The parameters may or may not
beina"_loop".

Thisisthe inverse of the required matrix for CRY SCON. If the axes are orthogonal
(orthorhombic, tetragonal, cubic systems), the off-diagonal elements are zero and the diagonal
elements of the required matrix are simply the original crystallographic axis lengths themselves,
which aregivenin lineslike

_cell.length_a 42.560

The coefficients of the inverted matrix may be entered directly into the

Transformation Parameters dialog. The transformation should be on "Input atoms only",
otherwise CRY SCON will reject the original generated atoms as not being in the unit cell. The
result will be a set of atoms for a complete molecule, with atomic coordinates on the
crystallographic axes. Some of these atoms may be redundant in the original crystal symmetry,
which may be given in the mmCIF filein lines like

_symmetry.space_group_name _H-M 'P43212

If there is sufficient interest in using mmCIF in crystallographic (not molecular) form, the
capability to transform automatically can be added to CRY SCON.

2.1.1.4 Import IZA file
Import | ZA (International Zeolite Association) File [File menu]

See the Import File dialog for general aspects of importing atomic-structure datafiles.

The 1ZA has an extensive database of natural and synthetic zeolites available on the WWWeb,
but does not seem to have an option for export of the data - it will be necessary to cut-and-paste
the information into a text file.

Go to the Web page for the Database:

http://www.iza-structure.org/databases/
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and select "Collection of Simulated XRD Powder Patternsfor Zeolites". This should
show amatrix of structure types by three-letter code - select one of these. Y ou can also
access structures in other ways, but you need to end up on a page showing options for X-
ray powder diffraction together with the structure data. There should be linesfor
"Material name" ..."Composition:" ... "Crystal Data:" and others, with the fractional
coordinates for the atoms in atable.

Mark the top right part of the page with your mouse, starting with the three-letter code
centered at the top, and going below the atomic-coordinates table. Do not include the
"Reset" and "Submit" buttons and material below thisline. Do not include the column
of options on the left of the page. Copy the marked information into the clipboard in the
standard way.

Now, in aword processor, open a new text (ascii) file. Paste the clipboard contents into
thefile. Savethefile, givingita".iza" extension if possible. Hereisasample (or look
inthe ZEOLITES subfolder for sample .izafiles):

LAU

Material nanme: Launontite

Conposition: | Ca4(H20) 18| [Si 16A 8I48]

Refined conposition: |Ca4(H20) 18| [Si 16A 80(48]
Crystal data: Space group: Cl2/nl (# 12)
a = 14.8538 A b = 13.1695 A ¢ = 7.5421 A
al pha = 90° beta = 110.323° gamm = 90°

X-ray Rietveld refinenment, Rwp=0.115, Rp=0.090, RF2=0.046
Coment: unique axis b, cell choice 1
Reference: Artioli, G and Stahl, K
Zeolites, 17, 249-255, (1993)

At omi ¢ coordi nates Atom na
CA Ca 0.2601 0.5 0.737 1.0
SI1 Si 0.2368 0.3838 0.156

e rmfactor x y z PP B(iso)
3
1
SI2 Si 0.0763 0.3834 0.325 1
1
.7
.0
.0

Fo
.4
.0
.0
.0

.8
.1
.6

P Wwo

AL1 Al 0.1315 0.3080 0.737
260 0.5 0.219 1.0 0
2084 0.3744 0.919 1.0 1.
1384 0.3838 0.552 1.0 O.
146 0.3454 0.203 1.0 2.9
3205 0.3185 0.248 1.0 0.
043 0.5 0.267 1.0 0.71
013 0.3083 0.743 1.0 2.
-(H20) 0.029 0.171 0.0
026
5 0.

1
2
2
9
66
55
2
7

9

3
.45
.92
6

2 1.0 4.03

-(H20 0.401 0.5 0.02
-(H20 0.5 0.467 0.
-(H20 0.1426 0.129 0.3

.5 2
.05
3.1

TEmBIARRRBRR
888Roco000000
QQQQoocoocoo
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2.2 Control Window

Thiswindow, which has controls like adialog, is present whenever adata set isin memory. It
lists the input atoms and allows easy modification of them and access to the main operationsin
CRY SCON.

The Symmetry button allows specification or modification of the current symmetry for the
origina or old atoms - it calls up the Symmetry dialog, if an option has not been selected, and
either the Space Group Symmetry or Custom Symmetry dialogs if the option has been selected.

The Transform button brings up the Transformation Parameters dialog, which allows
specification of the parameters for the new crystal. The unit-cell and atomic coordinates of the
new crystal are displayed in an output text window which is called from the

Transformation Parameters dialog. If you want to carry out certain operations on the old crystal
only, such as Export (File menu), Powder Diffraction or Precession Patterns (Diffraction Menu
menu), it is not necessary to Transform.

The Expand L ayer s button brings up the Expand Layers dialog - thiswill expand a crystal
structure on certain planes, increasing the length of the selected axis, but leaving the actual
short-range dimensions of most of the structure (bonds, etc. within layers) unchanged.

The New to Old button will replace the current Old or input atoms, cell and symmetry with the
the New or transformed atoms, cell and symmetry. Y ou will have the option of saving the
current file and assigning a new name to the transformed data.

Thelarge list window gives the current Old or original input atoms, which can be modified or
deleted with the buttons below the list. Atoms can also be modified by double-clicking on the
selection, which brings up the Input Atom (Site) dialog.

CRY SCON lists only distinct atomic positions, or sites, in thisdialog. These sites may have
multiple occupants, which are listed in the |nput Atom (Site) dialog. The site occupancy (SOF)
for each input atom shown in this dialog is the sum of the individual occupancies, which can be
accessed through the Input Atom (Site) and Atom Sharing a Site dialogs.

B(equivaent) is equal to Biso or derived from Uiso if the site isisotropic, or calculated
according to the formula below for anisotropic sites.

Beq = 2pi"2 (1/3) Sum(i) Sum(j) U(ij) a* (i) & () A(i) AG)

where a*'s are the reciprocal axis lengths and A's are the direct axis lengths.

The Bond L engths/Angles button brings up a dialog alowing calculation of bond lengths and
anglesfor all atoms or a selected atom - you can choose either the old or new crystal.
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2.2.1 Input Atom (Site)
Dialog Box: Input Atom (Site) [ Control Window ]

L abel. Each atom may be assigned alabel of up to 6 characters. Labelsin CRY SCON may not
contain any embedded blanks. Any embedded blanks or leading blanks in labels in import files
will be converted to underscores. Trailing blanks will be stripped.

Fractional coordinates. For crystals, thex,y and z coordinates should be in fractions of the
unit cell.

Type. It isusually expedient to enter the same type for all atoms which are bonded similarly
(e.g. al carbons, dl silicons, al six-coordinated cations, al oxygens, etc.) to save effort in
defining bonds and polyhedra. The atomic number can usually be used for the type, although
there are situations in which different type numbers should be used for the same element.

In atransformation, if atoms are found to be superimposed the type and other parameters are
simply taken from the initial atom generated in this position. Thusif it is known that atoms are
going to be consolidated, for example in a super- to sub-cell transformation, it may be a good
ideato use a single type for those which will be consolidated.

Any change in the Label or Type for the site will be transmitted to the first site occupant.

Thelist box gives the current occupants of the site. To modify individual occupants, double
click on the selection or click the Revise button.

In the Temperature Factor group, the type number as used in ORTEP must be specified. The
temperature factors are given below (in abbreviated form). The common type numbers are
given in the dialog; other types are rarely used nowadays. Supply the b, B or U double-
subscripted coefficients as required - in type O, the b coefficients are usually called betas. If the
typeisisotropic, the single value (B or U) isgiven in the (11) box.

ORTEP Types of Temperature Factors

Type 0 - e’(-b11h"2...+2b12hk...) *** Betaaniso

Typel- eN-b11h"2...+b12hk...)

Type 2 - 2°(-b11h"2...+2b12hK...)

Type 3 - 2°(-b11h"2...+b12hK...)

Type4 - eN(-.25(a*"2B11h"2...+2a*b*B12hk...)) *** B aniso

Type5 - er(-.25(a*"2B11h"2...+a* b* B12hk...))

Type 6 - ISOTROPIC - eM-B(sin(theta)/lambda)*2) *** B iso
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Type 7 - sphere of arbitrary radius
Type 8 - eM(-2pit2(a**2U11h"2...+2a* b*U12hk...)) *** U aniso
Type 9 - eN(-2pin2(a*"2U11h"2...+ax b* U12hk...))

Type 10 - ISOTROPIC - e’(-2pi*2U(sin(theta)/lambda)”2) *** U iso (not astandard ORTEP
type)

2.2.2 Atom Sharing a Site
Dialog Box: Atom Sharing a Site [ Input Atom (Site) dialog ]

This lists the properties for each occupant of asite.

Site occupancies in CRY SCON do not include space-group multiplicities and the total for a
fully-occupied site should be 1.0. If Import or Export filesinclude multiplicities CRY SCON
should convert as necessary.

The Type and Site Occupancy will be used in the intensity calculations for Powder or
Precession patterns. For this purpose, the type number should be avalid atomic number, unless
the SCATFAC.DAT file (containing the scattering factors) is modified.

Any change in the Label or Type of thefirst occupant will be transmitted to the main entry for
the site in the Input Atom (Site) dialog.

The Element, Charge and Scattering Number are parameters specific to some import/export

file types, and are not used by CRY SCON. They may not be meaningful unlessthe dataiis
exported in the same format in which it was imported.

2.2.3 Bond Lengths and Angles
Dialog Box: Bond Lengthsand Angles [ Control Window ]

This supplies the parameters for the computation of the list of bond or interatomic distances and
angles centered on one or al of the input atoms. Y ou can select either original (Old) or
transformed (New) atoms. The radio buttons determine whether distances and angles are
computed for all input atoms or only the one currently selected in the Control Window or in the
edit box.

Only 36 atomsin addition to the central atom are allowed, so the distance limit for central-
ligand should normally not be more than about 4 Angstroms. Angles are only calculated for
ligand pairs at less then the ligand-ligand limit; if you want to determine angles for atoms on
opposite sides of the central atom, the ligand-ligand limit should be twice the central-ligand
limit.
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The results of the distance and angle calculations are written to a file called either Bondsl.ccd
(original atoms) or Bonds2.ccd (transformed atoms) in the home directory (see

Files used by CRY SCON), and then shown in a Text window (see Types of Windows ). This
window has its own menus for editing and saving the text file. From this Text window, return to
the Control window and the ordinary operating mode of CRY SCON by clicking in the Control
Window, or with the Window menu.

Errorsin bond lengths and angles are not calculated by CRY SCON. Thisis because sufficient
data are seldom available for accurate calculation - it would be necessary to have the complete
variance-covariance matrices for both the unit-cell and atomic-parameter refinements. The
difference between the correct error values and those calculated using only the standard
deviations of the parametersis usually not large, but discrepancies between values in the
original publications and those calculated by CRY SCON could create confusion.

2.2.4 Expand Layers
Dialog Box: Expand Layers [ Control Window ]

This option will expand a crystal structure on certain planes, increasing the length of the
selected axis, but leaving the actual short-range dimensions of most of the structure (bonds, etc.
within layers) unchanged. It operates on input atoms (origina crystal), leaving the symmetry
unchanged.

Any atoms which are exactly on the expansion plane (for example K atomsin a mica structure)
will remain on the expansion plane, and thus bonds from these atoms to other parts of the
structure will be lengthened. Bonds connecting structural layers will also be lengthened.

The Expansion factor isthe amount by which the selected axisisincreased. For example, if
the c-axisis 10.0 Angstroms before conversion, an expansion factor of 1.5 will changeit to 15.0
Angstroms.

Expand on axis. This selectsthe axis to be lengthened. Fractional coordinates of most atoms
on this axis will be changed. The other two axes, and fractional coordinates on these axes, will
be unchanged.

Number of planes. There are often several symmetrically identical planes cutting the selected
axis. For example, there may be identical mirror planesat 0.0 and 0.5. Y ou must determine this
number from examination of the space-group symmetry.

Expand at zero. There may be a choice of location of the expansion planes. Normally this will
be a choice between the set of planes at fractional coordinate zero (on the expanded axis) and
another set at some rational fractions. For example, if the Number of planesis 2, there may be
aset at 0.0 and 0.5 and another at 0.25 and 0.75. If the Expand at zer o box is checked, the
expansion will be at the first set.

At the moment an arbitrary location of the expansion plane is not supported, and for low-
symmetry crystals, or those which have a choice of more than two locations, it may be necessary
to adjust al coordinates so that the expansion planeis at zero. If this situation is common,
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support for arbitrary location will be added.

Tolerance. Thisisused to decideif an atom is exactly on the expansion plane, in which caseiits
coordinate on the expansion axis will not be changed - that is, it will remain exactly on this
plane. Toleranceisin fractional coordinate units (not Angstroms). |If you want atoms which
are exactly on the expansion plane to remain in continuity with the remainder of the structure,
their fractional coordinates on the expansion axis should be changed by greater than the
tolerance. Usually thiswill result in duplication of the atoms.

2.2.5 File Menu - Control Window
New - Step-by-step input of anew CRY SCON data set.

Open - Openanold CRYSCON datafile.

Close - Closethe current graphics window.

Save - SaveaCRY SCON datafile.

Saveas - SaveaCRY SCON datafile with anew name

Import File - Shows a pop-up menu with the file types currently supported. Thisincludes:

--Free-form (.inp) Thisallowsinput of atomic coordinates and other information from almost
any source.

--CCDC FDAT filesfrom the Cambridge Crystallographic Data Centre.

--SHEL X .INS filesfrom the program system of Prof. G. Sheldrick.

--CIF - Crystallographic Information Files.

--DBWS/LHPM Rietveld files.

--ICSD Inorganic Crystal Structure Database files.

--ORTEP Origina or ORTEP Il atom information.

--XTLVIEW Drawing program.

--RIETAN Rietveld program files.

--GSAS Datafiles (.EXP) filesfrom the Los Alamos Lab system - may include magnetic
vectors.

--AM MINERAL Datafilesfrom the American Mineralogist structure data base.
--FULLPROF . All-purpose refinement program - may include magnetic vectors.
--ATOMS Atomic structure plotting program (Shape Software).

--VIBRATZ Normal-coordinate calculation program for crystals and molecules (Shape
Software).

--Ravel ATOMS This program is not the same as ATOMS by Shape Software, but i<
for EXAFS Analysis.

--WIEN2K This package performs electronic structure calculations of solids using
density functional theory (DFT).

Export File - Thiswill write unit-cell, symmetry and atomic-coordinate information in most of
the Import formats above.
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Quit - Quit CRY SCON.

2.2.5.1 Export Data File
Dialog Box: Export DataFile [ FileMenu]

Y ou have the choice of exporting the original (Old) or transformed (New) data. Note that the
transformed data is not otherwise saved except in the .ccd file which is written on
transformation, although it can be recalculated easily enough.

Most of the import/export formats supported by CRY SCON fall into one of two categories,
archival formats and refinement formats. The archival formats, such as CIF, ICSD and CCDC
tend to give only basic crystallographic information, including space group, unit cell parameters,
atomic coordinates and thermal parameters. The refinement file formats, such as DBWF,
SHEL X and GSAS generally contain much more information, such as scattering factors,
weighting factors and refinement flags. CRY SCON generally cannot provide al this latter
information, and it cannot be expected that a refinement-format file written by CRY SCON will
be successfully read in by the target refinement program (e.g. DBWF, SHEL X or GSAS)
without many additions and even some editing of the lines which are written by CRY SCON,
since even these lines may contain some refinement-specific data.

Space groups symbols may be written in many ways, for example space group number 116: P-
4c2; P-4 c2; P -4 ¢ 2; P4-c2. CRY SCON does not generally change the symbol - it is usually
exported in the form it was imported or entered. The Sglnfo routines used by CRY SCON can
interpret many of the variations, but export target program may not be able to interpret some
forms, and it may be necessary to edit the space group symbol after exporting afile.

Y ou can convert the type of the temperature factors, e.g. from beta'sto U's; and/or you can
convert from isotropic to anisotropic and vice versa. Of course not all export formats allow a
choice. If the Keep current form radio button is checked, the current temperature factors will
be kept, if possible . However, the export format may not support the current form, in which
case the temperature factors will be converted to atype which is supported.

The equivalent isotropic temperature factor, if converting from anisotropic to isotropic, will be
computed according to the formula:

Beqg = 2pin2 (1/3) Sum(i) Sum(j) U(ij) a* (i) a*(j) A(i) A(j) where a's are the reciprocal
axis lengths and A's are the direct axis lengths.

If the Remove multiple occupancies box is checked, only a single atom will be written for each
site, using the relevant data for the first atom in the list of occupants. If not, in most file formats
anew atom will be written for each site occupant - that is, the number of atomsin the export file
will be larger than the number of sites listed by CRY SCON.

Note that when different input atoms are consolidated during a transformation, for example
super- to sub-cell, CRY SCON does not attempt to combine the two sets of occupancies; it
simply takesthelist of occupants from the first atom generated.
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2.2.6 Input Menu

Title/Axes - Input of the 80-character title, selection of crystal system and specification of unit-
cell parameters

Symmetry - Selection of space-group or custom symmetry

2.2.6.1 Title/Axes
Dialog Box: Title/Axes [ Input Menu ]

Thetitle may have up to 80 characters of identifying information.

Y ou should supply the axis lengths and interaxial angles appropriate to the crystal system you
selected. Axislengths should be in Angstroms, and angles in degrees and fractions (not minutes
and seconds).

Although standard crystall ographic nomenclature gives the same letter (usually a) to symmetry-
equivalent axes, after the initial input CRY SCON may call al axes, whatever the system, "a, b,
and c" and angles "Alpha’, "Beta' and "Gamma'.

2.2.6.2 Symmetry
Dialog Box: Symmetry [ Input Menu - Control Window - Transform Dialog ]

The authority and source of information for crystal symmetry is normally the International
Tables for X-ray Crystallography . However, any space-group symmetry may be used for the
atoms. There are two options for selecting or entering symmetry information.

Space group from table - Choose a space group by symbol or number.

Custom Symmetry (xyz) - Enter all theindividua operations as fractional x,y,z coordinatesin
the unit cell.

Each choice calls up a sub-diaog.

2.2.6.2.1 Space-Group Symmetry
Dialog Box: Space Group Symmetry from Table [ Symmetry dialog ]

Space-group symmetry is obtained using licensed excerpts from the SGInfo program of Ralf
Grosse-Kunstleve.

Y ou can specify the space group in any of three ways: 1) the Hermann-Maughin (H-M) or
International symbol; 2) the Hall symbol (S.R. Hall: Acta Cryst., A37, 517, 1981); or 3) the
number of the group in the International Tables for X-ray Crystallography .

International TablesVolume. Y ou have the option of using the older version of the Tables
(called the Second Edition : various revisions and reprints from 1952 to 1979) in which the
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symmetry information wasin Volume I, or the newer version (1983 onwards) in which itisin
Volume A. The principal difference between the two versions is that in the older one the unique
axis of amonaclinic group is assumed to be the c-axis, whereas in the newer oneit is assumed
to be the b-axis. Thus entering the symbol P2/m gives two different orientations depending on
the volume selected. Y ou can aways specify the orientation by entering the long form of the
symbol,i.e P2/im11,P12/mlorP112/m.

The H-M or Hall symbol can be typed into the appropriate edit box in either short form or long
form, with or without spaces between positions. However, it is usually safer to select the
symbol from the list box at the bottom, which gives the standard-form symbols for al the space-
groups. Clicking the Select button copies the relevant data to the edit boxes at the top; it does
not actually generate the symmetry. Symmetry generation is done after you click OK - this may
take afew seconds.

If the space group you select does not appear to be consistent with your choice of axes, a
warning box appears, but in most cases consistency is not required. However, if you selected
trigonal rhombohedral axes in the Title/Axes dialog, only arhombohedral space group may be
selected. Thisisdone by adding :R to the end of the symbol in the case of H-M symbols, or
asterisk (*) in the case of Hall symbols. If you select the rhombohedral setting and then switch
to the Custom Symmetry option, the lattice type will be P; it will be R if the axes are hexagonal.

Origin of coordinates. Inthe International Tables, 24 space groupsin the orthorhombic,
tetragonal and cubic systems are given with a choice of origin: 1) not on a center of inversion or
2) on acenter of inversion. These two origins are selected by adding :1 or :2 respectively to the
end of the H-M symbol or the number. Although the origin on the center is second in the Tables
and in thelist, if the number is omitted this will be the default. Thisdifferenceinoriginis
explicit in the Hall symbol, and other choices of origin may be specified for any space group
with the Hall symbol. Note aso that the origin may be shifted before transformation (see
Transformation Parameters).

2.2.6.2.2 Custom Symmetry
Dialog Box: Custom Symmetry [ Symmetry Dialog ]

CRY SCON can access al the standard orientations for space groupsin the International Tables
but there are still afew possibilities for alternate settings of symmetry elements with respect to
structure axes which are not listed in the Tables . In some cases displacement, rotation or
permutation of atomic coordinates may not be convenient, and it may be easier to enter the
symmetry operations for the non-standard setting. These are sometimes given in reports on
structures (e.g. Wyckoff, Crystal Sructures). Note however that often only the operations for
specia positions are given: CRY SCON needs all the operations for the general position.

Some Import formats do not give a space-group symbol, and symmetry is supplied in the form
of operations as xyz, or as actual numerical matrices. CRY SCON converts numerical matrices
to xyz form.

The Symboal is not used by CRY SCON for transformations, unless you switch to the
Space Group Symmetry option. However, the Powder and Precession options require avalid
space-group symbol - they must use the symmetry from the symbol rather than the custom
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Symmetry.

Get Space Group Symbol. This button will attempt to identify the space group from the
operations, the lattice type and the centric/acentric setting. If the operations contain an
inversion center or lattice centerings, CRY SCON should identify them and they can be removed
at your option. Clicking the Change Symmetry Option button will automatically causes an
attempt to identify the space group.

If you specify Centric, rather than Acentric, you must enter only half of the symmetry
operations (as given in the International Tables ), related to any others by the center. Thetwo
sets or halves of the operations related by the center will have opposite signs on the x, y and z
coordinates. The Centric choice implies that the origin of coordinatesis on a center of
inversion. If the space group is actually centric, but the origin is not on a center, select Acentric
and enter all the operations. Note that for a transformation the atoms can be shifted (Pre-
symmetry trandlations) in the Tranformation Parameters dialog, to place the origin either on or
off an inversion center.

The Bravais lattice type isin most cases the capital letter which begins the space-group
symbol. However, CRY SCON uses a somewhat different convention from the standard for
trigonal crystals: if you are using hexagonal axes for arhombohedral crystal (whose standard
space group symbol will always begin with "R"), enter "R" - if you are using the primitive
rhombohedral axes, enter "P".

In the Operations group, you must enter all the "symmetry operations’ for the most general
position in the structure. Click on the Add Line button to add aline, Delete to remove one.
Note that there should be only one operation per line. Enter or edit the line in the edit box to the
right of the list.

2.2.7 Diffraction Menu

Y ou can do Powder diffraction, either as a diagram or alisting, or a Precession pattern.

The Font item in this menu will set the font for the legends in the diagrams as well asthe
lettering for the indices in the powder diagram.

The font for the powder listing, shown in a Text Window, is set in the Window Menu of the the
Text Window.

2.2.7.1 Powder Diffraction

Dialog Box: Powder Diffraction [ Diffraction Menu ]

Y ou can compute the pattern or list for either original (Old) or transformed (New) atoms and
unit cell.

If you select aList, thelist will appear in a Text window (see Types of Windows). There will
be alinein thelisting for each crystal form, or symmetry-unique set of reflections (with center
of inversion assumed). If there is more than one wavelength, the 2-theta and relative intensity
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will be listed for each in that line.

If you select a Graph, you may show either Bar s or a Curve - the curve will use Gaussian lines
with the selected full width at half maximum (FWHM). For acurve, the location of individual
reflections will be shown as a short bar underneath the curve.

The Line width pertains to the width of all lines or "pen strokes" in the graph, not the width of
each spectral peak (FWHM).

If the Vertical scale factor or magnification is 1.0, the strongest peak will just fill the plot area.
If you want to see more detail in the weaker reflections, this factor can be increased and the
stronger reflections will be truncated.

If the atom records include temperature factors, they will be used. If an atom has no
temperature factor, the B isotropic value in the Default temperature factor box will be used.
No absorption or extinction corrections are applied.

Scattering factors used by default are those for neutral atoms from Volume 4 of the
International Tables (1974) edition. Atom type numbers must be atomic numbers, or must
correlate with the order of the entriesin the SCATFAC.DAT file. Thisfile may be edited to
supply different scattering factors (see Files Used by CRY SCON). Type numbers are taken
modulo 100, that is 6, 106, 206 etc. all indicate carbon. By default number 99 is deuterium
(symbol D) and 98 istritium (symbol T).

There are five options for wavelength; averaged K (alpha); separate K (alpha)l and K (alpha)2;
averaged K (alpha) and (separate) K (beta); a single Specified X-ray wavelength; and Neutron
- wavelength. For the first three options, the X-ray tube target el ement must be selected in the
Radiation combo box. When two wavelengths are calculated, the bars indicating the second
(K(alpha)2 or K(beta)) are shown in red on the screen and in color output, and as adotted linein
black-and-white output.

In the case of K (alpha) and K (beta) the relative intensity of K(beta) must be specified. For
unfiltered radiation thisisin the neighborhood of 0.2. Of course it will be smaller for filtered
radiation.

This option gives only a semi-quantitative calculation of powder intensity, intended for purposes
of identification. For somewhat more elaborate options, including the ability to show multiple
species, try the program Powder Cell. For highly quantitative reproduction of powder patterns,
there are now many Rietveld programs available (see Import and Export files).

The results of the Graph option are shown in a graphics windows (see Types of Windows), and
when this window is active, the file menu allows graphics Print and saving Metafiles. Thereis
adifferent window for the Old structure and the New structure.

For this option to work properly the space-group symbol entered either in the

Space Group from Table or Custom Symmetry option must be valid for a standard setting. If it
isnot, it should be possible to transform to avalid setting. For example, the space group C-1is
sometimes used. It is possible firstly to transform to the primitive cell (use the standard matrix
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C->P). However, thiswould change the indices of the X-ray reflections. Alternatively, the
transformation could be from C-1 to P-1 with the same cell. The h+k odd reflections will have
zero intensity, but the other reflections will be indexed as for the original cell.

If the Index graph box is checked, the indices will be written above each line. Theindices are
displaced somewhat in avertical direction if they are close together, but to index complex
spectrait may be necessary to expand the scale using the 2-theta minimum and maximum
settings. The font for the indices is 0.8 times as large as the font for the legends. Thisfont is set
in the Window Menu, or the Diffraction Menu of the Control Window.

The 2-theta, d-spacing and intensity (on a scale of 0 to 100 for the strongest peak) for the point
of the cursor are written at the bottom of the window.

2.2.7.2 Precession Pattern

Dialog Box: Precession Pattern [ Diffraction Menu ]
Y ou can select either the original (Old) or transformed (New) atoms.

The Precession angle (mu) and Crystal-Film distance should match those of the real film to
which comparison isto be made. The Precession angle determines the extent of the patternin
reciprocal space. If the Fixed Scale option (rather than Fit in Window) is selected, the pattern
will bein true scale. This can be altered with the Factor, which is 1.0 by default.

The part of the reciprocal lattice shown is determined by the Horizontal axis, the Other axis
and the Level. For example, for a Okl pattern with b* horizontal, the Horizontal axis is b*, the
Other axisisc*, and the Level isO.

Reflections are shown as squares whose area is proportional to the calculated relative intensity.
The intensities are normalized based on the number of electronsin the unit cell (intensity of
reflection 000) and the smallest reciprocal lattice spacing in thisnet. The Intensity factor
scales the edge length, not area, of the squares (thusit really applies to the structure factor).

If an atom has no temperature factor, the B(iso) value in the Default temperature factor edit
box will be used. Extinction and absorption are not considered.

Scattering factors used by default are those for neutral atoms from Volume 4 of the
International Tables (1974) edition. Atom type numbers must be atomic numbers, or must
correlate with the order of the entriesin the SCATFAC.DAT file. Thisfile may be edited to
supply different scattering factors (see Files Used by CRY SCON). Type numbers are taken
modulo 100, that is 6, 106, 206 etc. all indicate carbon. By default number 99 is deuterium
(symbol D) and 98 istritium (symbol T).

If the Show grid box is checked, the reciprocal lattice will be shown asagrid in red on the
screen and color output, or as dotted lines in black-and-white output.

The results of this option are shown in a graphics windows (see Types of Windows), and when
thiswindow is active, the file menu alows graphics Print and saving Metafiles. Thereisa
different window for the Old structure and the New structure.
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For this option to work properly the space-group symbol entered either in the

Space Group from Table or Custom Symmetry option must be valid for a standard setting. If it
isnot, it should be possible to transform to avalid setting. For example, the space group C-1is
sometimes used. It is possible firstly to transform to the primitive cell (use the standard matrix
C->P). However, thiswould change the a and b reciprocal axes and the indices of the X-ray
reflections. Alternatively, the transformation could be from C-1 to P-1 with no change in unit
cell. The h+k odd reflections would be calculated and have zero intensity, but the other
reflections will be indexed as for the original cell.

If the Show extinctions box is checked, systematically absent reflections are marked with a
small circle, inred in color display and outpuit.

Clicking on areflection will bring up an alert box showing the indices, the d-spacing, the
structure factor (|F[), the intensity (I) and the Lorentz-polarization factor.

The font for legendsis set in the Window Menu, or the Diffraction Menu of the Control
Window.

2.2.8 Window Menu

The Window menu lists al the possible windows in CRY SCON - those which do not
actually exist are greyed out. Select awindow to make it active, or bring it to the front.

When a Text window or either the Powder or Precession graphics window is active, the
first item in the menu is a Font selector. In the Text window, this acts on the entire text
in the window and the font appliesto al Text windows. The font for the powder and
precession windows applies to both windows and to all text, except that the index
lettering in the Powder window is 0.8 times the size of the lettering for legends.

2.2.9 Help Menu
The Help menu offers the following commands, which provide you assistance with this
application:

CRYSCON Help Topics. Thisbrings up the Help system. Use the Content, Index or
Find tabs to locate information on a particul ar topic.

About. Thisgivesthe version number of CRY SCON. For Macintosh, the About dialog
iseither in the Apple menu (OS 8/9) or the Application menu (OS X).
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2.2.10 Transformation Parameters

Dialog Box: Transformation Parameters [ Control Window ]

The structure which isinput and listed in the Control Window is referred to asthe Old or
original structure, and that derived from it is referred to as the New or transformed structure.

There are two options for the symmetry of the transformed crystal; you can specify the
symmetry, or use the program FINDSYM, by Harold T. Stokes and Dorian M. Hatch, to find
the space group. [FINDSY M is not available for Macintosh]

If you want to specify the symmetry, click on the Symmetry button if the symmetry of the New
crystal isto be different from the Old symmetry. The default symmetry isthe same asthe Old.
The symmetry specified here pertains to the New orientation, not the Old, i.e., CRY SCON does
not transform symmetry, so you must supply the correct symbol or operations for the
transformed unit cell. The symbolsfor different orientations are listed in the International
Tables Vol. 1(1952) Table 6.2, and in the file HALL.DAT - these symbols all appear in the list
box in the Space Group Symmetry dialog.

Theuse FINDSY M option actually uses the program FINDSY M.EXE (Windows; or findsym
[Linux]) exactly as provided by its authors - this program must be in the CRY SCON home
directory [for Linux, the files data_space.bin and _wyckoff.bin must also be present].
FINDSY M writes its output to the file FINDSY M.LOG, and this output is copied line by line to
the transformation results file output by CRY SCON. FINDSY M usesits own Tolerance, which
issimilar to that used by CRY SCON (below) in determining whether atoms lie on special
positions.

FINDSY M use certain conventions and there are limitations to the output - the results will use
the following settings.

monoclinic: unique axis b, cell choice 1
rhombohedral: hexagonal axes
origin choice 1

Thus this option cannot be used to transform into arhombohedral cell, for example. However,
the symmetry of the transformed structure can be determined, then the Transformed to I nput
option in the Input menu can be used, then the structure can be transformed again to the desired
setting of the space group using that specified symmetry.

The Number s after decimal is applied to the fractional atomic coordinates. Atomic positions
from X-ray diffraction typically are good to 5 or fewer decimal places, but some programs may
reguire the positions of atoms which are in special positions containing coordinates of 1/3, 2/3
etc. to be specified more precisely. This should occur only in rhombohedral crystals using
hexagonal axes (and even then atoms in the unit cell can be selected which do not contain the
rhombohedral lattice trandations, or in some hexagonal crystals.

Three types of transformation can be carried out.
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1. Trandation only simply adds the Pre-symmetry trandlations to the input atoms (Old or
original atoms) and does nothing else.

2. Input atoms only applies pre- and post-matrix translations and the translation matrix, but
does not try to fill out the unit cell for either the old or new setting. The number of New
symmetry-unigue atoms will be the same as that of the Old input atoms. Thisisthe only option
which will transform anisotropic temperature factors. This option may be used for simple
reorientation involving interchange of axes, and other transformations which do not involve a
change of symmetry or primitive unit-cell volume. It can be used for primitive to non-primitive
transformations and vice-versa, and transformations among different non-primitive Bravais
cells. Again, the correct symmetry for the New orientation must be supplied. Use this option
when transforming from Cartesian coordinates, asin an imported PDB or mmCIF file, to crystal
coordinates

3. Full unit cells will transform all atomsin the Old unit cell to those in the New unit cell,
generating new atoms when necessary (supercell or decrease of symmetry) and averaging atomic
position when that is necessary (subcell or increase of symmetry). Anisotropic temperature
factors are not transformed - they are converted to isotropic. Vectors are transformed, although
if the symmetry is changed the new vectors are not guaranteed to be consistent with the new
Symmetry.

The Tolerance is used to decide if atoms are coincident, and their positions should be averaged
(if the unit cell is decreased in volume, or the symmetry isincreased). Thetolerancein
Angstroms is converted to fractional coordinates on x, y and z, and applied to each atomic
coordinatein turn. That is, atoms are considered to be coincident if they fall within a unit-cell
shaped box with edges of length equal to the tolerance.

The Number s after decimal box specifies the number of figures after the decimal for fractional
atomic coordinates. Thisaso appliesto CIF file export.

Use symmetry on vectors. If thisbox is checked, vectors (such as magnetic spin vectors) will
be operated on by the symmetry elements. If not, the atoms generated from each input atom will
all have the same vector as that input atom. Note that CRY SCON, unlike ATOMS, does not
apply Shubnikov symmetry.

The Standard matrices combo box will supply matrices for some common unit-cell
transformations. These matrices should all preserve the chirality or "hand" of the structure -
other combinations of signs on the coefficients are possible, particularly for the last five
matrices for smple interchange of axes.

The parameters specified on the left side of the Tranfor mation Parameter s dialog, going
downward in the dialog, correspond to the operations successively carried out by CRY SCON -
see General Procedure for more detail. After setting and verifying all parameters, click on the
Transform button, and the results appear in a new text window (see Types of Windows).

First, Pre-symmetry trandglations may be applied to the input atom coordinates. If the origin
for your atomic coordinates does not correspond to that of the standard symmetry specified for
the Old crystal, corrections must be made here.
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If you have the inverse transformation matrix or that for going in the opposite direction to that
desired - that is, you have the "new" to "old" matrix - you can enter the matrix and then use the
Invert Matrix button.

---Trandation only (origin shift) option

Nothing beyond Pre-symmetry trandlations is done — the remainder of the parameters are
ignored.

---Input atoms only option.

The Pre-matrix translations are applied to the Old input atoms, they are transformed with the
matrix, and the Post-matrix trandations are applied. (Pre-symmetry trandations are not
used).

Use this option if you want to convert a set of atomsin Cartesian coordinates to fractional
crystal coordinates, as for a PDB file.

---Full unit cells option

CRY SCON now generates all the atomsin the Old unit cell. If the origin of the New unit cell
differs from that of the Old, with respect to the common symmetry elements, you must make
corrections in either the Pre-matrix translations or Post-matrix tranglations edit boxes. Such
differences among sub/supergroups are common, and it may be necessary to study the diagrams
and coordinates in the International Tables to get these translations. CRY SCON transforms the
vectors on the input atoms with the symmetry matrices. In the case of special positions, the
vector is taken from the first atom generated for that position. For subsequent atoms generated
for that position, the new vector is compared and a warning message issued if the two vectors
are not the same.

The transformation matrix isin the nine edit boxes. Some common standard transformation
matrices may be selected in the Standard matrices combo box to the right. The upper three
coefficients (first line) of the matrix give the New a-axisin terms of the old a, b and c axes.
Likewise the second and third lines specify the new b- and c-axes.

CRY SCON now transforms the coordinates according to the matrix supplied, adding additional
atoms by tranglation if necessary, or averaging atomic positions when necessary. The
Tolerance is used to decide when atomic positions are "coincident”, and must be averaged. The
tolerance should be large enough to avoid having quasi-superimposed atoms in the result, but of
course it must be less than the smallest bond length in the structure. Setting this may take some
trial and error. A value of 0.4-0.5 seemsto be large enough for even rather extreme cases of
atomic shiftsin sub/supercells and sub/supergroups.

CRY SCON does not attempt to average vectors on coincident atoms; it takes the vector from the
first-generated atom and issues a warning message if vectors on subsequent coincident atoms are
not the same.

Post-matrix trandations may be applied here if the standard origin for the New space group is
different from that of the Old space group. Thisis an alternative to the Pre-matrix translations
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- it should not be necessary to use both.

CRY SCON now appliesthe New symmetry to eliminate symmetry-equivalent atoms. Again a
tolerance is applied to decide if atom positions are "coincident”. This generates a standard set
of symmetry-unique atoms, or the "asymmetric unit". However, in many cases when generating
asubcell or increasing the symmetry the averaging process does not put the new atoms exactly
on special symmetry positions and the calculation must be repeated in part - see

General Procedure.

The Clear button resets the transformation matrix to the identity matrix, and it also resets the
Symmetry to be the same as that of the Old structure.

The Transform HKL file button will read afile containing index data and transform the indices.

2.2.10.1 Transform Face or Reflection Indices

Transform Face or Reflection Indices File[ Transformation Parameters dialog ]

This option will read afile containing alist of X-ray (or other diffraction) reflections, or just a
list of crystal faces, and transform the hkl indices to a new axial system or unit cell.

Y ou will be asked to specify the input file, and the output file (which must be different).

The data to be transformed must be in atext or ASCI|I file with one hkl per line. The data must
be in fields separated by spaces.

Specify the numbers of the three fields or columns containing the hkl indices (integers). Other
fields or columns will simply be copied to the output file (these are read as strings). There will
be one space between the fields in the output file - column formatting will not be preserved.

Lines not containing three valid numbers in the columns specified for hkl index datawill simply
be copied to the output file. In many cases this will give an output file which isidentical to the
input file except for the transformed indices. If thereis any doubt about whether other types of
datain the file may contain three numbers in these fields, the valid output with the transformed
indices can be cut and pasted back into the originad file.

To reach this option, click on the Transfor m button in the Control Window. The only data
which is used in the Transformation Parameters dialog is the tranformation matrix. Itisnot
necessary to click the Transform button to transform indices.

It ispossible to have invalid transformed indices. For example, if the a-axisis halved, the
indices (100) will be tranformed to (1/2,0,0). CRY SCON will attempt to clear such fractional
indices, for example changing (1/2,0,0) to (1,0,0) and (1/2,1,0) to (1,2,0). Note that such
changed indices will be valid for morphology, but not necessarily for diffraction. If one of the
extrafieldsin the file (not indices) is the d-spacing (or central distance derived therefrom) it
will not be changed and thus some values may not correspond to the new indicesiif fractions are
cleared.
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2.3 Text Windows

When atext window is active, the menu bar contains a File Menu, for saving and printing the
contents, and a standard Edit Menu for editing the contents.

To return to the main menu bar, click on the Control Window (see Types of Windows), or use
the Window menu.

The Transform button in the Tranformation Parameters dialog lists the transformed atom
parameters and other data to a separate Text window. TheListing optionin the

Powder Diffraction dialog (File Menu) lists the data to a Text window, as does the

Bond L engths and Angles dialog (called from the Control Window). Each window actually
displays the contents of afile, called respectively LIST.DAT and BONDS.DAT. Thesefilesare
written over again each time the respective option is called, so if they are to be preserved they
should be saved with the Save As command in the File Menu, using a different name.

2.4 Powder Diffractogram Window

Thisis agraphics window which appears as the result of the Powder Diffraction dialog (Graph
option) in the Diffraction Menu. It may show either the old or original atoms, or the new or
transormed atoms.

To return to the the Control Window if it is not visible, use the Window Menu.

File Menu. In addition to the standard Save, this has options for printing and graphics file
output.

Window Menu. To set the font (for all diffractogram windows) and switch between windows.

2.4.1 File Menu (Diffraction Graphics)

The options here for graphics output (Print, PostScript, Raster, Metefile or PICT) are for
Powder or Precession graphicsonly.

2.4.1.1 Print Graphics

Dialog Box: Print GraphicsImage [ File Menu (Powder) or File Menu (Precession) |

PostScript printing is standard in Linux, so graphics printing is handled by the
Direct PostScript option, not by the dialog below.

If the Standard printer dialog on OK box is checked, the Print dialog supplied by the
operating system or the printer driver comes up after you click OK. Use that dialog to set the
number of copies, the orientation (Portrait/Landscape) or the resolution.
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Color output gives essentially the same image as on the screen, with the bars for a second
wavelength in the Powder pattern, and the reciprocal-lattice grid in the Precession pattern being
inred. If the Color box is unchecked, these lines are shown dotted. If you have a color printer,
you may need to make a choice between color and black-and-white printing in one of the printer
dialogs as well as with the Color printing checkbox in thisdialog. This choice may be an
option in the standard printer dialog above, or you may need to set it in the Print Setup option
in the File menu.

See Frames for details of the frame and frame units.

2.4.1.2 Page Settings

This allows setting of the paper type or size, the standard orientation (portrait or
landscape) and the paper margins. Marginswill only be used in Text Windows.

For Macintosh, margins are set in Page Margins.
2.4.1.3 Page Margins

----- Macintosh only----

This dialog sets the margins for Text Windows. Use the Page Setup dialog to choose page
size and orientation.

2.4.1.4 PostScript Output
Dialog Box: Direct Postscript Output [ File menu]

PostScript printing is standard in Linux, so for non-3D output, including diffraction
diagrams, printing is routed to this dialog, not the Print Graphics command in the
File menu. Output can be directly to the printer or to an EPSfile, as for Windows
(below).

---- Windows and Linux only ----

This option can be used to write Encapsulated Postscript (EPS) files for transmission of

graphicsto other software, aswell as for direct output to a Postscript printer. This direct
output is generally superior to, aswell asfaster than, the output from the normal

Print Graphics command in the File menu if your printer is PostScript. The Destination
option sends output either directly to aprinter or to afile in standard EPS (Encapsul ated
Postscript V3.0) format.

Screen Preview.
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Most word-processing and publishing software cannot display an EPS file on the screen
unlessthe file has a special bitmap attached, called the screen preview. Thisis actually a
sub-filein the TIFF format. The pixel depth of thisfile can be set in the

PostScript Settings dialog (Settings button). The pixel depth of the preview is set to that
of the screen, and the pattern seriesis set to fine (see Raster Files).

---- Macintosh only ----

This option can only be used to write Encapsulated Postscript (EPS) files for
transmission of graphics to other software. For direct output to a Postscript printer, use
the Print option.

Screen Preview .

Most word-processing and publishing software cannot display an EPS file on the screen
unless thefile has a specia attachment, called the screen preview. Thisisactually a
PICT in the resource fork of thefile.

---- End Linux/Windows/Macintosh only ----

Settings button (PostScript Settings dialog). On or before first using the Dir ect

PostScript Output command, you should set or verify the settings in this dial og,
especially the port to which the printer is attached.

Fonts in PostScript output . Depending on your system configuration (Windows or
Macintosh, printer type and driver), the PostScript fonts supported by a PostScript printer
may or may not appear in the dialog for selecting fonts which may be called from the
xxxx dialogs. Furthermore, you may want to write EPS files for a printer which is not
even connected to your computer. These dial ogs thus have an option to specify a
character string for the PostScript font. This string specifies the typeface, and includes
the weight (normal, bold) and other attributes (italic or oblique), but does not include the
Size - the sizeis specified in the font dialog. There are certain

standard PostScript typefaces which are present on most PostScript printers.

See Frames for details of the frame and frame units.

2.4.1.5 PostScript Settings
Dialog Box: PostScript Settings [ Direct Postscript Output Dialog]

The page size, page margins and dots per inch/centimeter should be determined by the
actual printer used for final output; if these are not correct, the drawing may not be
scaled and/or placed on the page correctly.
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Preview Color. If you select a screen preview (TIFF bitmap or PICT sub-file) in the
Direct PostScript Output dialog, and if color output is selected, you can specify either a
color or black-and-white bitmap. The Screen option uses the color depth of the the
current screen display. Black-and-white PostScript output always uses a 1-bit or black-
and-white screen preview.

---- Windows only ----

If you are using direct output to a printer you must select the Port; thiswill be either
"LPTn" or "COMN". Also, if you are using a serial port for the printer, you must set or
verify the data transmission parameters, such as baud, parity, etc., even if the port
currently shown isthe correct one. Thisisdonein the Ports item of the Windows
Control Panel (not in CRY SCON).

2.4.1.6 Raster Files
Dialog Box: Raster (Bitmap) Files [File menu]

--WindowsOnly ----------

This command can write filesin four different formats (File type): Windows device-
independent format (.BMP); PC-Paintbrush (.PCX); Tag-image-format (.TIF); and
Portable Network Graphics (.PNG) files.

--Macintoshonly---------

This command can write files in the Portable Network Graphics (.PNG) format. The
PICT/Clipboard option (File menu) can also write raster or bitmap files, in the PICT
format.

--End Windows/Macintosh only----
See Selection of File Format below for information on choosing the format.

The drawing may be either black and white or color. If black and white, the pixel size is
1-bit. For color filesthe pixel size may in some cases be selected. In Windows, 16-bit is
only available for .omp files. In Macintosh, 8-bit (256-color) isonly availableif the
screenis currently set at this color depth.

If the Compress box is checked, . TIF files are compressed with run-length encoding,
which is one of the required formats under the TIFF 6.0 standard. However, some
applications may not support thistype of compression, or may reject .TIF filesfor other
reasons. Also, if the Compress box is checked, 4- and 8-bit .BMP files are compressed.
1-bit and 24- bit .BMP files are never compressed. Owing to a Windows system bug,
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compression of 4-bit .BMP files may not work when banding is used (see below). .PCX
files are dways compressed. with their own format. 24-bit .PCX files can compress
well, whereas 24-hit .TIF filesare only partially compressed (and then only if there are
large areas of black, white or grey), and 24-bit .BMP files are not compressed at all.
PNG files also are always compressed.

See Frames for details of the frame and frame units.

Maximum memory. Windows and Macintosh both use virtual memory , which means
that they pretend that a hard disk can be used in place of actual hardware memory chips.
For some applications thisis useful, but when writing raster filesit usually resultsaform
of lingering death involving "disk thrashing”, or constant reading and writing of datato
the hard disk.

CRY SCON is capable of imaging and writing raster files in segments or bands to avoid
this problem. This requires repeating the entire drawing process for each band, but this
usually is much faster than the reading/writing to disk involved in using virtual memory.
To do this requires knowing how much actual chip memory isavailable. Unfortunately,
at present Windows does not provide this information in away that can be used for both
16- (standard Windows 3.1) and 32-bit (Windows 95/98/NT/XP) systems. Thus the user
may need to determine this by trial and error using the M aximum memory parameter.

When the Maximum memory parameter is set to zero, CRY SCON will simply ask the
system for ablock of memory large enough to image the entire drawing at once. This
amount of memory is printed out in the dialog which appears after starting the raster
imaging: "nnnn bytes required, mmmm bytes available - will require 1 bands". If this
amount of memory is greater than the amount of chip memory available, Windows will
use virtual memory, which istypically manifested by constant running of the hard disk
for long periods (disk thrashing). If you change the M aximum memory to some amount
smaller than nnnn (say half), CRY SCON will only request this amount of memory from
the system, and virtual memory may not come into play. A Maximum memory setting
should be good for a given session, regardless of the size of the raster file; larger files
will use more bands. However, the amount of memory available may depend on whether
other applications are active.

The amount of virtual memory is determined by the available space on the hard disk. If
thisisinsufficient, CRY SCON will automatically use bands, but since virtual memory is
being used, it may still be advantageous to use a M aximum memory value which will
increase the number of bands.

Selection of File Format. The choice of format dependsfirst of al on what formats are
supported by the target software (paint program; publishing program; etc.). Beyond this
the first choice should be PNG, second choice PCX, and then PICT, TIF or BMF
depending of what is supported and how much memory or disk space is available.
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Asof 1997, the preferred graphicsfile typesfor the internet were GIF and JPEG.
However, GIF uses the LZW compression scheme copyrighted by Unisys Corp., which
in principle charges alicense fee for every application using it. JPEG files are compact
but involve losses and degradation of the image and are thus not suitable for CRY SCON
files.

The PNG format is intended to be areplacement for GIF, and in fact is superior to most
other formats, being lossless and giving very good compression for the type of images
generated by CRY SCON. Essentialy all major software vendors have subscribed to the
PNG convention and releases from 1998 onward should support it.

Most TIF files also use LZW compression, but CRY SCON does not use this type of
compression because of the copyright problem. The run-length-encoding which

CRY SCON does use is supposed to be supported by all TIF readers, but in fact some do
not support it, and this algorithm does not work well for 24-bit (RGB) images.

PICT bitmap files on the Macintosh are compressed by the system software and the
agorithm may vary. PNG filesare usually smaller.

There are dozens of raster graphics formats and it will never be possible for CRY SCON
to support all of them. CRY SCON users who work with raster files should consider
investing in aconversion program - there are many such programs which are not
expensive. The PNG home page (www.cdrom.com/pub/pnp) has links to many
shareware and conventional commercial conversion packages.

2.4.1.7 Metafiles
Dialog Box: Metafiles [ FileMenu ]

---- Windows Only ----------

Windows metafiles are basically vector images (but including fills) that can be rescaled
without necessarily losing resolution. They record the drawing commands that are used
for the screen or standard printer output, but the result may depend on the software or
device for which they are intended. A metafile image may either be saved in the
Clipboard, to be Pasted into another application, or written to afile.

CRY SCON can write three types of metafiles. The original or Standar d metafile format
has proven inadequate for transmitting scaling information, and many applications do not
even accept Standard metafiles. Placeable metafiles, aformat which was originated by
Aldus Corporation, contain scaling information in an additional header. The standard
and placeable metafiles have the WMF extension. WMF or standard files are 16-bit
format, i.e. use 2-byte integers. Enhanced metafiles are 32-bit format files which also
contain scaling information. They are the preferred type of metafile for usein 32-hit
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Windows systems (Windows NT or Windows 95), but cannot be used in standard 16-bit
Windows 3.10r Win32s.

Original (16-bit or WMF) metafiles can be written with either of two Scaling M odes;

I sotropic or Anisotropic. Isotropic supposedly keeps the same proportions. Generally,
Isotropic isthe best asit alows rescaling while preserving proportions. However, some
applications only accept Anisotropic files, and some ignore the scaling mode completely.

When writing to afile, to prevent loss of resolution, CRY SCON uses a standard scaling
of 2540 dots or pixels per inch (1000/cm). However, some drawing applications may
not read the scaling correctly (assuming 72 dpi) and it may be necessary to rescale the
drawing after importation.

When writing to the clipboard, CRY SCON uses the current screen resolution, which
usually isabout 92 dpi. Thisis because most drawing applications assume screen
resolution or 72 dpi. The clipboard image can be either 16-bit (.wmf) or 32-bit (.emf)
according to the setting of the Type option.

See Frames for details of the frame and frame units.

Limitations of Metafiles. Asdesigned and implemented by Microsoft, the metafile
allowsrecording of all Windows drawing commands, so that a file image can be a copy
of what is shown on the screen but rescalable. Unfortunately non-Microsoft drawing
applications (e.g. Corel Draw, Adobe Illustrator) sometimes implement metafiles
incompletely or incorrectly so that there are some limitations in metafiles written by this
option, in order to allow them to work in as many applications as possible. It many be
necessary to try many combinations of settings (Destination, Scaling mode, Type of file)
to get satisfactory results in an importing program.

1) Resolution for the clipboard is now that of the screen, typically 72-96 dots-per-inch
(dpi) - earlier versions of ATOMS used 2540 dpi. The lower resolution should not cause
problems except for very complex drawings - if adrawing looks good on the screen, it
should look good in adocument. If the clipboard is unsatisfactory use afile.

2) Bitmap patterns for black-and-white images cannot be used. Fills are transmitted as
gray shades which are interpreted by the importing application and/or printer.

3) A background is always present, to insure correct scaling. With some care, this
drawing element may be removed in importing applications.

4) Thereisno clipping of the image, although some importing applications may use the
drawing frame for clipping.

5) Transmission of theimage in Corel Draw with the Clipboard may require use of
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Edit/Paste Special rather than a simple Paste.

6) Adobe Illustrator generally does not do well with labels - is may be necessary to use
an EPSfilefor Adobe Illustrator. Label backgrounds may not be transmitted in other
applications.

If ametafile is not satisfactory, araster file can be used. PNG raster files are often
smaller than metafiles, especially for complex drawings. Also, many drawing programs
now support import of EPS (Direct PostScript) files. EPSisusualy the preferred type of
filefor Adobe lllustrator.

2.4.1.8 PICT/Clipboard
Dialog Box: Clipboard/PICT [ File meny]

Note that thistype of output may be referred to elsewhere as Metafile output. This
option can write images either to the Clipboard or to PICT files, in either of two formats:
(a) arescalable 2-dimensional Picture or metafile, or (b) araster image or bitmap.

Macintosh Pictures, as used here, are images containing lines or vectors and fills of
regions defined by lines, that can be rescaled without necessarily losing resolution. They
record the drawing commands that are used for the screen or standard printer output, but
the result may depend on the software or device in which they are used.

Bitmaps or raster images record every pixel, so they are not susceptible to undesirable
modification by other software. Although most "painting” software can resize bitmaps,
thisusually causes aloss of quality, so it is best to save a bitmap in exactly the desired
size. Note that you can also save bitmapsin the PNG raster format (File menu), which
is superior is some respectsto PICT files.

If color output is selected, you can choose either 16- or 32-hit color depth - 8-bit (256-
color) files cannot be written.

Y ou can select the nominal dots per inch/centimeter, but note that programs which read
the file may ignore this and show the image at 72 dots per inch.

See Frames for details of the frame and frame units.
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2.5 Precession Pattern Window

Thisis agraphics window which appears as the result of the Precession Pattern dialog (Graph
option) in the Diffraction Menu. It may show either the old/original atoms, or the
new/transormed atoms.

To return to the the Control Window if it is not visible, use the Window Menu.

File Menu. In addition to the standard Save, this has options for printing and graphics file
output.

Window Menu. To set the font (for all diffractogram windows) and switch between windows.

3 Reference
Topics of general interest.

Atom Parameter Files (Free-Form)

ATOMS and VIBRATZ files

Files used by CRY SCON

Frames

Samples

Standard PostScript Type Faces

3.1 Atom Parameter Files (Free-Form or .inp)

Thistype of ASCII or text file may be used to read in atomic coordinates alone, or to supply
complete structure information. Listings of atomic coordinates from almost any source can be
used as the basis of afree-formfile.

CRY SCON will also export this type of file, which can be read into ATOMS, SHAPE or
VIBRATZ (Shape Software).

All or part of the parameters for each input atom, namely label, fractional coordinates, type,
radius and display colors and pattern numbers, can be read in. Y ou can also supply default
values for some parameters, so that the parameters neither need to be present on every line of
the file, nor need to supplied through the dialog.

Except for the TITL line, keywords and actual values to be read in should be separated by
spaces or commas, and there should be no spaces within keywords or values. Thereisno need
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for aignment by column, except that keywords should start in the first column.

The input file may contain two overall types of lines;, General and crystallographic information
lines; and actual data or atomic parameter lines .

General and crystallographic information lines. These lines should all precede the atomic
parameter lines. Each line consists of a keyword followed by one or more values or character
constants. The keyword should start in the first column and be followed by at least one space
before the actual values. Where more than one value is called for, they are separated by spaces.
All of these lines are optional - when afree-form fileis used for import (File menu), if any lines
are absent, default values will be supplied.

TITL line. Upto 76 characters (may contain spaces).

CELL line. The unit-cell lengthsin Angstroms and the interaxial anglesin degrees (6 floating-
point values). If the atomic coordinates are Cartesian, the axes should be 1.0 and the angles
90.0.

SPGP line. The Hermann-Maughin or standard International symbol for the space group.
There should be no spaces in the symbol, although there may be underscores (which are ignored
when the symboal isinterpreted.

HALL line. TheHall symbol for the space group. There should be no spaces in the symbol,
although there may be underscores (which are ignored when the symbol isinterpreted. If this
line comes after the SPGP line (or that line is absent), the Hall symbol will be used in the
Space Group Symmetry option.

SYMM lines. These give symmetry operatorsin "xyz" form, that isin the form in which the
coordinates of the general position are listed in the International Tables for X-Ray
Crystallography. Fractions must be given as integers separated by a slash ("1/2", "2/3"), rather
than decimals ("0.5", "0.333"). Thex, y and z positions must be separated by commas and there
should be no spacesin the operator. There should be one line for each operator. If the space
group is centrosymmetric, only half the operators need be given, if the origin is on a center of
inversion. If the origin is not on a center, all operators must be given and the space group
should be denoted non-centric inthe LATT line. If these lines come after the SPGP and HALL
lines (if the latter are present), the Custom Symmetry option will be used.

LATT line. Thisgivesthe Bravaislattice type (single capital character), followed by a space
and O if the space group is centrosymmetric or 1 if it is non-centric.

FACTOR line. A single (floating-point) factor which multiplies all the fractional or atomic
coordinates.
Atomic parameter lines :

The file should have all the information for each atom, except for temperature factors, on a
single line with a maximum of 80 characters per line, and the values must be in fields , which
are set off or delineated with either spaces or commas. There can be no spaces or commas
within fields. The names of fields are given in the following in capitals, but in the actual input
they may be lower case; all letters are converted to upper case when the lineisread in.
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DEFAULT lines supply valuesto the parameters, such as colors, which are not read in for each
atom. If default values are not entered in this way, default values are obtained from the separate
ELEMENTS file, using the chemical symbol of the atom which is assumed to be in the first two
characters of the atom label. See the further description of DEFAULT lines and the
ELEMENTS file below.

FIELDS lines. Theselines set up the CRY SCON input parameters which are to be read from
thefile, and the order in which they areto beread. . Thisisfollowed by the keywords giving the
order of thefields. The allowed keywords are as follows (INTEGER fields may not contain a
decimal point):

1) LAB - (6 characters maximum). Any label for the input atom may be used, but the label
normally begins with the chemical symboal for the element. The first two characters may be used
to determine default values for some of the parameters, as described below. The characters may
be upper or lower case. Thisisarequired field.

2) COO - Thisactually denotes three floating-point fields giving the fractional atomic
coordinates. After input, the coordinates are multiplied by the number in the FACTOR line, if
thislineis present. These are required fields.

3) TYP - Thisisthetypewhich isused in locating bonds and polyhedra. INTEGER

Fields 4-9 arefor usein ATOMS and are not used by CRY SCON, but if the data was originally
imported from ATOMS (.STR), they will be written in an Export file for re-introduction into
ATOMS.

4) RAD - Thisisthe radius used when the atom is plotted as a sphere. FLOATING-POINT

5) RMC - Thisisthe color number for the atom rim or edge. INTEGER

6) FLC - Thisisthe color number for the atom fill. INTEGER

7) RMP - Thisisthe pattern number or gray shade used in black-and-white display or output.
INTEGER

8) FLP - Thisisthe b/w pattern number for fills. INTEGER

9) PEN - Thisisthe pen number used for atom outlinesin pen plots. INTEGER

The following fields may be used by CRY SCON.

10) TFB - Temperature factorsin B or bij (beta) form, types O (anisotropic) or 6 (isotropic) in
ORTEP. If thiskeyword is present, the temperature factor(s) are present on a second line for
each atom, inup to six fields The order is 11, 22, 33, 12, 13, 23. If the second value is absent
or zero, the temperature factor will be read asisotropic. Note that CRY SCON will save

temperature factors only if at least one atom has non-zero for the first value or b11.

11) TFU - Temperature factorsin U or uij form, for anisotropic type 8 in ORTEP. Similar to
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TFB. Isotropic U values will be given number 10, although thisis not standard ORTEP.

12) VEC - Atomic vectors, e.g. for magnetic spins or vibrational displacements. If this
keyword is present, the vector coefficients are present on a second line, in four fields. Thefirst
three are the relative components in the structure axes, and the fourth is the length. Vectors and
temperature factors may not both be present.

13) DUM - Thisdesignates afield (character, integer or floating-point) that existsin the input
data line, but should be ignored by CRY SCON.

Note that the actual atom data lines do not contain any keywords. The keywordsin the FIELDS
lines set up the sequence of parametersin each data line.

An example FIELDS line:
FIELDSDUM LAB COOTYPRAD
Some corresponding data lines:
1C10.12340.23450.3456 6 1.2
2H20.43210.54320.654310.1

Herethefirst field, which is simply a sequence number, must be ignored by CRY SCON, and is
designated with aDUM.

Here is an example of some lines copied from an (old) ATOMS .STR file (spinel):
FIELDSDUM LAB TYP COO RAD

1 MG1 12 .12500 .12500 .12500 .000

2 AL2 13 .50000 .50000 .50000 .000

3 O3 8 .26200 .26200 .26200 .000

There should normally be a FIELDS line at the beginning of the atomic parameter lines, but
additional FIELDS lines can be inserted at any point to redefine the fields. If thereisno FIELDS
line, the fields are by default; LAB and COO.

In the actua data lines, fields denoted INTEGER above should not be more than 6 characters;
the COO and RAD fields (floating-point) should not be more than 20 characters.

DEFAULT line. Thisisused to set particular default values for fields other than LAB or COO.
DEFAULT must be the first 7 characters. Then the default values are indicated with the name of
the field connected with an equals sign (with no intervening spaces) to an appropriate value.
Example default line:
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DEFAULT TYP=1 RAD=0.95 FLC=15

There are twelve possible input fields for each input atom, or each linein thefile, plus the
placeholder DUM field. The LAB and COO fields are required for each atom and must be read
in from the file; the other fields are optional. If the latest FIELDS line does not define afield for
aparticular parameter, then the value of the missing parameter is determined by reading the first
two characters of the label (LAB field) and trying to identify the element. Y ou can turn off
defaults, thereby accepting the values on the input atom line, with a line containing the word
DEFAULT and no other keywords.

3.2 ATOMS and VIBRATZ files

CRY SCON users may want to use or transform the data in the Shape Software programs
ATOMS, for drawing crystal structures, and VIBRATZ, for normal -coordinate cal culations.
The data files for both these contain far more data than CRY SCON requires, and while Crycon
will Import either type of datafile, it will not export either type. The procedure for taking data
from these programs, using it or transforming it, and returning it to these programsis as follows.

1) In CRY SCON, directly Import the ATOMS (.STR) or VIBRATZ (.\VBR) files. All data
required by CRY SCON should bein these files. Of course both of these programs handle
molecules or polymers aswell as crystals, and CRY SCON deals only with crystals.

2) If the objective isto simulate Powder or Precession patterns or diffraction listings, no
transformation is required - just select the desired option from the Diffraction Menu.

3) Totransform the data, follow the procedure outlined in General Procedure.

4) To return the transformed datato ATOMS or VIBRATZ, select Export in the File menu, and
write a Free-form (.LINP) file.

5) ATOMSor VIBRATZ can now import the .INP file through the Import optionsin their File
menus. In the case of ATOMS, it is also possible to read the datainto an existing file (for
example the original datafile) through the Input Atoms dialog (Input menu). This hasthe
advantage that all pre-existing specifications, including bonds and polyhedra, are preserved.

When an ATOMSfileisread into CRY SCON, the data on color and atomic radius are
preserved, although they are not used by CRY SCON. They are written out in the .INP export
file and will be read back into ATOMS (see Atom Parameter Files).

The program SHAPE will also read .INP files, so can use transformed data from CRY SCON.
Transformed {linkN

3.3 Files Used by CRYSCON

CRY SCON recognizes two file folders or directories; the home directory and the data
directory.

The home directory is the one containing the CRY SCON program file or application. This
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directory must also contain the following data and setup files:

SCRPTR Thisisthe setup or preferencesfile for CRY SCON. If it is damaged or lost another
will be created, with default values. Thisfile isreplaced after the first startup with a user-
and platform-specific file.

HALL.DAT Thisisthefile containing space-group data.
CIFDIC.SHT Thisisarequired dictionary file for importing CIF files.

SCATFAC.DAT Thisfile contains the X-ray scattering factor data for neutral atomsin the
exponential form as given in the International Tables, Vol. 4. Thisfile may be modified to use
other scattering factors (e.g. for ionized atoms). The scattering factors are keyed by sequence
number as read from thisfile to the atom type. There is a maximum of 100 scattering factors.
Type numbers are taken modulo 100, that is 6, 106, 206 etc. all indicate carbon. By default
number 99 is deuterium (symbol D) and 98 is tritium (symbol T). For neutron diffraction
involving isotopesit is a simple matter to copy the line for the element in question into a
position which is unlikely to be used, such as numbers 93 to 97, and change the neutron
scattering length, which isthe last coefficient (the first 9 coefficients give the X-ray form
factor).

The following files are always written to the home directory.

BONDSL1.CCD, BONDS2.CCD Thesefiles contain the results of the Bond L engths and
Angles command (Control Window).

POWDER1.CCD, POWDER2.CCD Thesefiles contain the listing of d-spacings, etc. from
the Powder Diffraction command (File Menu), Listing option.

The BONDSN.CCD and POWDERN.CCD files are rewritten every time you use the Bond
Lengthsand Angles or Powder Diffraction (Listing) commands. Thus to save these results
permanently, use Save As (File Menu) to save them with a different name.

Thedata directory isthe one containing the current datafile. Thisdirectory issaved in the
SCRPTR or user- and platform-specific file, and thus the Open command returnsto it when you
start up CRY SCON.

infile .CCD Thisisthe output file from the Transform command (button) in the
Transformation Parameters dialog - here infile is the name of the CRY SCON data file (infile
.CCO). It containsalisting of the atomsin the original unit cell and the transformed unit cell,
and the transformed symmetry-unique (input) atoms. It isdisplayed in a Text window (see
Types of Windows).

infile. XXX Export files are given the appropriate default extension (.XXX), and are written by
default in the data directory, although you can write them with any extension. Changing the
directory in which the file is written resets the data directory.
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3.4 Frames

Frames [ Print Graphics, Metafiles ]

With printed output, you have a choice of using the full page, or confining the output to aframe
. For Metafiles (File menu) output always goesto aframe.

If you are using the Fixed scale mode for a Precession or Powder pattern, the imageis clipped
to the frame. Otherwise, the image is scaled to fit the frame.

In printed output, the frame can be positioned on the page; the offset gives the displacement of
the upper left corner of the frame from the upper left corner of the page.

Y ou can choose the units for the size and offset of the window; either inches or centimeters.

3.5 Samples

All the examples are real minerals, and the tranformations are between non-equivalent but
similar structures, not just changes of axes. There are files transforming each structure in the set
to the other structure(s).

The transformations type is Full unit cells.

M ar casite(mc)-ar senopyrite(as). In addition to the substitution of Asfor one of the sulfursin
S2 groups, the cell and symmetry are different.

Columbite(co)-huebnerite(hb)-wodginite(wo). These oxides have the same basic structure,
differing in the pattern of cation substitution.

Cubic bor acite(boc)-orthorhombic bor acite(boo). Thisis a high-low temperature transition.

The low-temperature orthorhombic form is ferroelectric and can take several orientations with
respect to the cubic high-temperature form. Some atomic displacements are quite large.

3.6 Standard PostScript Typefaces
Standard PostScript Typefaces (Font Families)

The names of the fonts should be entered exactly as given, with no embedded spaces. |If
your printer does not recognize afont string, it will probably default to Courier.

Times Roman Family

Standard: Times-Roman
Slanted: Times-Italic
Bold: Times-Bold

Bold Slanted: Times-Boldltalic
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Helvetica (Swiss) Family

Standard: Helvetica
Slanted: Helvetica-Oblique
Bold: Helvetica-Bold

Bold Slanted: Helvetica-BoldOblique

Courier Family (fixed pitch)

Standard: Courier
Slanted: Courier-Oblique
Bold: Courier-Bold

Bold Slanted: Courier-BoldOblique

3.7 Settings, Preferences or Configuration Files

CRY SCON has in the past saved various settings in afile, SCRPTR, whichisin the
same folder or directory asthe CRY SCON program or executable file. SCRPTR saves
genera settings which may be used for all data, such as frame sizes for printing and
graphicsfile output and is aways saved before exiting the program.

Starting with V2.1, thisinformation is saved in a standard type of file which is specific
to the platform (Windows, Mac or Linux), and thisfileisin alocation specific to each
user. Thus each user will have his or her settings preserved, even if only one copy of the
CRY SCON folder/directory and executable fileis present. Further, these settings will be
carried on as new versions of CRY SCON areinstalled.

Specifically the new settings files will bein the following locations:

Windows: \Documents and Settings\username\CRY SCON.ini

Macintosh: :Users.username:Library:Preferences.CRY SCON Preferences

Linux: /home/username/.CRY SCON (note the period - thisis a hidden file)

where username is the name of the current user logged in.

The SCRPTR file still exists. On startup, CRY SCON looks first for the user-specific
file, and if thisis not present it reads the values from the SCRPTR file in the folder or
directory containing the CRY SCON executable file. Thereafter the user-specific fileis

written and used.

The Windows and Linux versions have separate Help server programs, and these write
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their own user-specific preferencesfiles. Thesefileswill be in the above locations, and
the program name is "wxHTMLHelpController" instead of "CRY SCON". Inthe
Macintosh version, there is no separate Help server program and the datafor the Help
windows (window sizes and location and fonts) isin the CRY SCON Preferences file.

In the Settings menu, there are now options to read and write the "archive" SCRPTR file
- thiswrites the values currently used by CRY SCON. If there are multiple users of

CRY SCON, the SCRPTR file should probably be written only the the system
administrator. All users may read the files to get the "standard" or archive values.
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